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1 EINFUHRUNG

CanMonitor ist eine GUI-basierte Applikation zum Betrieb eines CanActors. Er ermdglicht im Zu-
sammenspiel mit dem CanActor Uberwachung, Analyse und einfache Simulation von einem CAN-
Bus. Nach dem Import einer CAN-Datenbasis kénnen CAN-Nachrichten und CAN-Signale, sowie
die Sendeknoten am CAN interpretiert und deren logische Signalwerte Ubersichtlich dargestellt
werden. Die aus der CAN-Datenbasis importierten CAN-Signale lassen sich leicht und einfach kon-
figurieren und via CAN-Botschaft auf dem Bus Ubertragen. Es ist auBerdem maoglich, CAN-Knoten
zu aktivieren/deaktivieren und gezielt nur die Empfangsbotschaften eines oder mehrerer CAN-
Knoten zu senden. Weitere Features des CanMonitors sind im unter ,Features des CanMonitor im
Uberblick” aufgelistet.

CanMonitor ist vollstandig in C++ unter dem Einsatz der kostenfreien und systemunabhangigen
Bibliothek ,,gtkmm™ umgesetzt. Er ist kostenfrei verfligbar und stellt zusammen mit dem CanAc-
tor ein nUtzliches Werkzeug wahrend der Entwicklung, Simulation und Analyse von CAN-
Netzwerken dar.

1.1 SYSTEMANFORDERUNGEN

Der CanMonitor ist auf allen gangigen Computersystemen lauffahig. Vor dem Start wird empfoh-
len die beiliegenden Treiber der CanActor-Hardware zu installieren. Die Installationsanleitung be-
findet sich auf der beiliegenden CD.

e MS Windows 2000 / XP / Vista / Windows 7
e Empfohlene Mindestaufldsung 800 x 600
e CanActor-Hardware-Treiber

1.2 FEATURES DES CANMONITOR IM UBERBLICK

e Uberwachung, Analyse und Simulation von CAN-Netzen
e Unterstltzung von CAN-Datenbasis (.dbc und .xml)

e Darstellung von CAN-Signalen im Rohdatenformat und im logischen /physikalischen For-
mat

e Busstatistikanzeige

e Beliebige Anzahl von CAN-Trace-Ansichten mit den dazugehdérigen umfangreichen Filter-
konfigurationsmaoglichkeiten

e Protokollierung des CAN-Busverkehrs in eine Textdatei

e umfangreiche Filtermdglichkeiten zur besseren Visualisierung des Busverkehrs und mehr-
stufiges Nachrichten-Filterkonzept (Hardware-Filter / Software-Filter)

e Interpretation von Daten-, Remote- und Error-Frames

e Passive-Mode, Unterdriickung des Acknowledgements

e Konfiguration und Ubertragung von beliebig vielen einzelnen oder zyklischen Daten- u.
Remote-Frames

e Unterstltzung der drei auf jedem CanActor fest verbauten Transceiver-Typen (High-Speed,
Low-Speed, Single-Wire und dazugehdrige Transceiver-Modi)
e Unterstltzung der CAN-Protokolle 2.0A (11-Bit ID) und 2.0B (29-Bit ID)

e Einstellung von standard- und benutzerdefinierten Baudraten



1.3 FENSTERAUFBAU UND -KONFIGURATION

LAbbildung 1: Fensteraufbau” beschreibt das Fensterlayout des CanMonitors. Das Layout ist voll-
standig dynamisch und kann somit beliebig verschoben, skaliert und konfiguriert werden.

Als besonderes Highlight lassen sich beliebig viele Trace-Fenster erstellen, individuell konfigurieren
und einzelne davon aus dem Hauptfenster herausnehmen bzw. wieder einbinden. Dies ist beson-
ders nitzlich bei der CAN-Netzwerkanalyse. GroBbuchstaben kennzeichnen die einzelnen Ansich-
ten:
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Abbildung 1: Fensteraufbau
A = Sendeleiste a = Start des Einstellungsdialoges
B = Nachrichten-Fenster b = Aktivieren der I/O-Ansicht
C = Trace-Fenster ¢ = Aktivieren der Statistikansicht
D = Konsolen-Fenster d = Aktivieren der Datenbasisansicht
e = Vollbildmodus
f = Ein-/Ausblenden der Sendeleiste
g = Ein-/Ausblenden des Nachrichten-Fensters

h

Ein-/Ausblenden des Trafficfensters

Ein-/Ausblenden des Konsolen-Fensters

Die einzelnen Fenster lassen sich per Buttonklicks auf die mit den Kleinbuchstaben gekennzeich-
neten Toolbuttons aus dem Layout herausnehmen bzw. wieder einbinden. AufBerdem unterstitzt
der CanMonitor als den Vollbildmodus, wodurch die ganze Arbeitsflache des Systems ausgenttzt
werden kann.



Das Nachrichten- (B) und Trace-Fenster (C) sind Bestandteile der Ubergeordneten ,|/O-Ansicht”.
Neben der I/O-Ansicht bestehen noch zwei weitere Ansichten (Statistikansicht und Datenbasisan-
sicht), die mittels der Toolbuttons ,b", ,,c” und ,d” ausgewahlt werden kénnen:
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1.3.1 MENULEISTE

File Run ‘window Settings Create Info

File:

1| & mew project 9
2 | & open project 10
3 | B Save project 11
4 Save as.. 12
5|&

13
6 | § Import CAN database 14
T | & Export CAN database
8 | & Qui

ile

Run
& Connect to CAN
@ Disconnect From CAN

' Run bus simulation
i@ Stop bus simulation

£ Start File loaging
& Stop file logging

1 Neues Projekt erstellen

Bestehendes Projekt laden

Projekt speichern

Projekt unter anderem Dateinamen speichern

15
16
17
18
19
20
21
22

23
24

CAN-Datenbasis importieren

CAN-Datenbasis exportieren

2
3
4
5 Projekt schlieBen
6
7
8

Anwendung schlieen

Window

* General Ijo
Statistics
CAN database

H Fullscreen
-

W Create new traffic window

% Tralfic window configuration

v Show transmit bar
v Show send message view
v Shiws traffic view

v Show console view

9 Verbindung mit dem CAN-Bus aufbauen

10 Verbindung zum CAN-Bus trennen

11 CAN-Bus-Simulation starten

12 CAN-Bus-Simulation beenden

13 Protokollierung des CAN-Verkehrs in eine Textdatei starten

14 Protokollierung des CAN-Verkehrs beenden

Window:

15 Auswahl der |/O-Ansicht

16 Auswahl der Statistik-Ansicht
17 Auswahl der Datenbasis-Ansicht

18 Aktivierung Vollbildmodus

19 Deaktivierung Vollbildmodus

20 Erstellen eines heuen Trace-Fensters

26
27

Settings
¢ Bus settings

2 Traffic windaw configuration

Creats | Info |

2 Single message 32 | O sbout...
B2 Cyclic message

[0 Response messags

TR Traffic window



21 Starten des Dialogs zur Konfiguration eines Trace-Fensters
22 Ein-/Ausblenden der Sendeleiste

23 Ein-/Ausblenden des Nachrichten-Fensters

24 Ein-/Ausblenden des Traffic-Fensters

25 Ein-/Ausblenden des Konsolen-Fensters

Settings:
26 Starten des Dialogs zur CAN-spezifischen Einstellungen

27 Starten des Dialogs zur Konfiguration eines Trace-Fensters

Create:
28 Erstellen einer neuen CAN-Botschaft
29 Erstellen einer neuen zyklischen CAN-Botschaft

30 Erstellen einer neuen CAN-Botschaft (Datenbereitstellung bzw. Antwort auf ein Remote-
Frame)

31 Erstellen eines heuen Trace-Fensters

Info:

32 Starten des Info-Dialogs

1.3.2 SENDELEISTE

IDE: [ | ID: |0 RTR: [ | DLC: |5 |¥ Data: [0 0 1] 1] 0 1] 1] 0 | " Transmit |

Abbildung 2: Sendeleiste

Uber die Sendeleiste lassen sich im Online-Modus bzw. wihrend der bestehenden Verbindung zu
dem CAN-Bus einzelne CAN-Botschaften senden, die wahrend der Konfiguration nicht definiert
wurden. Somit besteht die Moglichkeit einzelne Tests durchzuflhren, ohne das Trace oder die
CAN-Bus-Aufzeichnung unterbrechen zu mussen. Durch das Anklicken der Checkbox ,,IDE” lasst
sich dabei der Botschaftsformat (Extended/Standard) einstellen. Im Eingabefeld ,ID” wird die
Botschafts-ID eingegeben. Die Checkbox ,RTR” ermdéglicht bei Aktivierung das Versenden eines
Remote-Frames, mit der man eine Anfrage an einen CAN-Knoten sendet, die mit derselben Bot-
schafts-ID und einem Daten-Frame beantwortet wird. Im Eingabefeld ,,DLC" (Data Length Code)
entscheidet man wie viele Datenbytes man versenden mdchte, wobei die dafur zustandigen Ein-
gabefelder automatisch angepasst werden. Alle numerischen Eingaben erfolgen dabei hexadezi-
mal. Durch das Anklicken des Buttons ,Transmit” wird die eingestellte CAN-Botschaft auf den
CAN-Bus Ubertragen.



1.3.3 I/O-ANSICHT
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Die I/O-Ansicht besteht aus Nachrichten- und Trace-Fenster. Das Nachrichten-Fenster besteht aus
einem Karteireiter, in dem CAN-Nachrichten, die vom Benutzer konfiguriert und versendet wer-
den kénnen, nach deren Kategorien in Karteien aufgeteilt sind. Das Trace-Fenster ist ebenfalls als
Karteireiter umgesetzt, wobei jede Kartei einer Trace-Ansicht mit einem separatem, flexibel kon-
figurierbarem Trace-Filter, entspricht. Die I/O-Ansicht wird mittels folgenden Toolbuttons in der
Werkzeugleiste aktiviert (alternativ Uber die Menileiste>Window->General 1/O):

1.3.3.1 NACHRICHTEN-FENSTER

Device messages | Single messages | Cyclic messages | Response messages

ModefMessagefSig | IDfWalue | Repetition | Active | SingleShot | &
P I aaG_MOQE
P I ELY_MOE ‘ ‘
¥ 1 Gateway_MQE 1
P 2 airbag_01 40 50 ms
P 2 pirbag_0z 520 200 ms
P ) BAP_Klim... 17330100x
0
_... Stufe0 (keineE..
... 70[min]
RV ¥

Abbildung 3: Nachrichtenfenster

Das Nachrichten-Fenster besteht aus einem Karteireiter (siehe Abbildung 3).

Der Reiter,Single messages” enthalt die zur Konfigurationszeit definierten Einzelbotschaften,
die wéahrend des Tracens versendet werden kdnnen. Nédheres dazu im Abschnitt ,Senden von
einzelnen CAN-Botschaften”.

Der Reiter ,Cyclic messages” enthalt die zur Konfigurationszeit definierten timergesteuerten
bzw. periodischen CAN-Botschaften, die Uberwiegend von der Hardware bzw. CanActor getrig-
gert werden. Somit ist es mdglich, echtzeitfahig zyklische Botschaften zu versenden und damit
CAN-Knoten und Restbussimulationen nachzubilden. Néhere Informationen dazu sind im Ab-
schnitt ,,Senden von periodischen CAN-Botschaften” enthalten.

Der Reiter ,Response messages” enthalt die zur Konfigurationszeit definierten Remote-Frame-
gesteuerten CAN-Botschaften, die automatisch als Antwort auf ein Remote-Frame mit demselben
Identifier versendet werden. Dieses Feature ist genau wie die periodischen Botschaften fir die
Nachbildung von CAN-Knoten bzw. Restbussimulation notwendig. Néhere Informationen dazu
befinden sich im Abschnitt ,Senden von ereignisgesteuerten CAN-Botschaften”.

Der Reiter , Device messages” enthalt die in der CAN-Datenbasis enthaltenen CAN-Nachrichten. Es
ist mdglich, nach dem Import von Datenbasisdateien einzelne Signale der Botschaften gezielt
einzustellen und zu versenden. Nahere Informationen dazu im Abschnitt ,,



Senden von CAN-Botschaften aus der Datenbasis”.

1.3.3.2 TRACE-FENSTER

Alle CAN-Botschaften, die Uber den Bus Ubertragen werden, werden ,eingescannt” und im Trace-
Fenster angezeigt. Das Fenster besteht aus einem dynamischen Karteireiter, in welches einzelne
Karteien eingefligt und entfernt werden kénnen. Beim Start des CanMonitors existieren nur zwei
Karteien, namlich die ,, CAN-Traffic”- und die ,Create”-Kartei. Durch das Anklicken des ,Create”-
Reiters erzeugt man eine neue TrafficcAnzeige. Alle Ansichten lassen sich dabei individuell konfi-
gurieren und filtern, sodass man z.B. eine Ansicht fir jeden CAN-Knoten hat oder die CAN-
Botschaften nach deren Eigenschaften sortiert.

S S| Bra SEEEE

e w0 RIR () DU (8 o) Dot | (0 (0 |0 [0 | (00 ) [0 | Tarsmt

Davin massages | S messages | Cyoc meseages | Raspanss messen
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o
..... o 5 000 Dytes: 0o Bpte . o
1 [0 [0 oo [q[o]s ] [ea o]0
el 432 ezloi

fo s 3¢ 36 e w3 52| 7] 2]¢1 ] (e85 ]s3[sz. 5.7 e
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/ T 5
>

Abbildung 4:Tracefenster an- u. abdocken

Die Filter-Einstellungen sind im Abschnitt ,,



Trace-Filterkonfiguration” beschrieben. Alle Karteien lassen sich aus dem Hauptfenster heraus-
nehmen und in einem getrennten Dialog anzeigen. Somit hat man die Mdglichkeit mehrere Traf-
fic-Darstellungen mit unterschiedlichen Filterkonfigurationen gleichzeitig zu sehen.



1.3.4 STATISTIK-ANSICHT

Die Statistik-Ansicht wird mittels folgenden Toolbuttons in der Werkzeugleiste aktiviert (alternativ

v
& & f & o X ®80 BB 6 2PEE ARBEBE

Uber die Menlleiste->Window->Statistics):

|Counter | Per secom d |percent | f 1o | cCounter |Percent =
# Busload [ 9% | fe 3DC 960 e 8% ]
& PeakLoad — 10% | e 3BE 401 H 3% N
¥ B DataTransfer azz01 ] 408 7] 3% |
S Pt TxDataTransfer 62049 o758,4 | S ~ o 301 39z H 3% |
¥ RsDataTransfer 20152 59 [ 24% ] b 3D 363 H 3% |
¥ 4 Cankvents 10691 f SE1 187 I 1% |
¥ (A Cantisgs 10631 e (R £ 5FO 40 [ 0% |
- ¥ @ Tuprsgs 7986 w3 U | ([ 47 [ 1% |
2 stdbata 7674 s | 5 ~H te 663 355 K 3% |
b B SRemate o oo | 0% | e 20 [ 0% |
i - (4 ExtData 362 26,0 ] 4% | P 654 14 [ 0% |
i e D ExtRemote 0 0,0 [ 0% | b g2 5 [ 0% |
L W D RMsgs 2705 490 B | 25% ] Fo 687 4 [ 0% |
Lo 6D stbata 2705 45,0 [ U S | | & sas 4 [ 0% |
o D SedRemate 0 0,0 [ 0% | e 4p 372 H 3% |
- D ExtData 0 0,0 [ 0% | f 101 570 H 5% |
Lo B2 ExtRemots 0 00 [ 0% | e 107 546 = A |
------ A BusErrors 0 0,0 [ 0% | o 116 18 [ 0% |
F 128 392 H 3% |
e 131 s12z ] 4% |
. s I B 1

Die Statistik-Ansicht ist in zwei Ansichten aufgeteilt:

Die linke Ansicht ist in die Spalten ,,Counter”, ,Per second” und , Percent” aufgeteilt. Die ,,Coun-
ter"-Spalte enthalt die Gesamtanzahl der jeweilig gezdhlten CAN-Events. Die ,Per second”-Spalte
enthalt die Anzahl der jeweiligen CAN-Events pro Sekunde und in der Spalte ,Percent” wird der
prozentuale Wert in Bezug auf das Ubergeordnete Event abgebildet, z.B.: , TxMsgs” bezieht sich
auf ,CanMsgs” und ,, CanMsgs” bezieht sich auf ,CanEvents”. Bei Tx- u. Rx-DataTransfer handelt
es sich um Zahler fur die Nutzdaten der CAN-Nachrichten (in Bytes).

Die rechte Ansicht ist in Spalten ,ID”, ,,Counter” und ,Percent” aufgeteilt. Jede Zeile entspricht
dabei einer gezahlten CAN-Nachricht.

Es wird fur jede CAN-ID ein Zahlerwert (Spalte ,,Counter”) und ein prozentualer Wert in Bezug auf
die Gesamtzahl der CAN-Nachrichten dargestellt (Spalte ,,Percent”).

In beiden Ansichten werden bei jeder Verbindung zum CAN-Bus die Zahler neu gestartet.

1.3.5 DATENBASIS-ANSICHT

3
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Die Datenbasis-Ansicht wird mittels folgenden Toolbuttons in der Werkzeugleiste aktiviert (alter-
nativ Uber die Menleiste->Window->CAN Database) :

Die Datenbasis-Ansicht ist in zwei Teilansichten aufgeteilt:



Databass-Explarer | | Mame | Message | MUK-Type | Starthic | Bitlength | ByteOrder | DataType | Factar | Off et | M A
» 3R pusList |E | P U Mator_1Z_alt Gateway_73 - [ i Tntel Unsigned T [ [}
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- B AAG_abschaltstu P U7 D _Geberl_im_Fzg Kessy 04 - 12 1 Inkel Unsigned 1 o 0
TV P ke _ID_Geberz_im_Fzq Kessy_04 - 13 1 Intel Unsigned L o 0
- B/ BaG_Anhaenger .. = P Uk _ID_Geber3_m_Fzg Kessy_04 - 14 1 Intel Unsigned 1 [ 0
BB P U7 Ky _ID_Geberd_im_Fzg Kessy 04 - 15 1 Intel Unsigned 1 0 0
P A0G_Blrker_HL_ W U7 kv ID_Geber_Suche  Kessy 04 - 17 1 Intel Unsigned 1 0 0
B o~ 4G Bliker HR P zas KIS Klemmen_Status. - 16 1 Intel Unsigned 1 0 0
- B AAG_Blinker_H_a » 8 zas KIS Klemmien_Status. - 17 1 Inkel Unsigned 1 o 0
- B/ R4G_Bremsl_dur U7 Log_Dateniogger R...  Log_Dateniogger... - o 4 Intel Unsigned 1 o 0
- B AAG_Eremsicht_. U Log ELv_Req_Dats  Log_ELV_Req - 0 64 Intel Urnsigned 1 0 0
B/ AAG_KD_Fehler P U7 MO_StartStopp_Mot... Mator_14 - 15 1 Intel Unsigned 1 0 0
B A0G_Kempschuts » U Mo kl_s0 Mator_14 - 19 1 Intel Unsigned 1 0 0 i
B A0G NSL_sktiv 3 P U MO HYE Fahrbersit.. Fotor 14 — 26 1 Intel . Unsioned 1 0 0 - i

Im linken Teil sind die einzelnen Elemente der Datenbasis sortiert unter den Sammeleinheiten Bus-
List, ECU-List, Node-List, CAN Messages und Signals aufgeteilt. Bei der Markierung eines Elements
im linken Teil werden Eigenschaften dieses Elementes im rechten Teil dargestellt. Es besteht die
Moglichkeit, die Listen nach beliebigen Eigenschaften zu sortieren, indem man den Kopf der je-
weiligen Spalte anklickt. Durch die Tastenkombination ,Strg+F” ist es moglich, nach einen be-
stimmten Eintrag aus der Liste zu suchen. Fir die Eingabe der zu suchenden Namen wird ein Ein-
gabefeld eingeblendet und muss mit der ,,ESC"-Taste beendet werden.

1.3.6 KONSOLEN-FENSTER

Message: Gateway_73  Signal: - CycleTime: 50 ms .

Byte 0: 0x00 Byte 1: 0x00 Byte 2: 0x10 Byte 3: 0x27 Byte 4: 0x00 Byte 5: 0x00 Byte b: 0x00

15 oo [ [0 [ o o [ o I o ] - o ) o ] [ o o [ Jo [ [ [ | [0 ' ] o | [ [0 [ [ [0 [a o ]}=

7lels|als|z]1 o] [1s]14)1zf1z[11]10] 9| 8] |z3]zz|21]20{19]18]17 16| |31|30|23|25|27 |26 |25 24| |39[35|a7 |36 (35 |34 |33 52| |47 46 ]aglaalsn 4lcs
ESP_Rollenmodus ren

Comments: b

Antrieb, Fahrwerk - = Extended, Infotainment, Komfort

[ 111 J =

| Message details | System messages | Hardware messages | Bus event errors | Queue errors

Das Konsolen-Fenster informiert den Benutzer Uber die aktuellen interne Ablaufe, sowie Fehler-
meldungen des CanMonitors und der CAN-Hardware. Die Meldungen werden im Karteireiter
,System messages” zusammen, sowie durch die Karteireiter ,Hardware messages”, ,Bus event
errors” und ,Queue errors” getrennt dargestellt. Besonders nitzlich kann dabei die Anzeige der
Plugin-Meldungen von Pluglns ohne eigene GUI sein. Der Plugin-Entwickler kann mit einem einfa-
chen Befehl eine Meldung, wie Verlaufsinformation, Fortschrittsanzeige oder Fehler auf dem
Konsolen-Fenster anzeigen lassen. Die Kartei ,,Message details” zeigt einige Informationen Uber
CAN-Botschaften, -Signale und -Knoten aus der Datenbasis.
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Abbildung 5: Einstellungsdialog

1.4 CAN-BUS-EINSTELLUNGEN

CAN-Bus spezifische Gerate-Einstellungen erfolgen im Einstellungsdialog, der durch Betatigen des
zugehorigen Toolbuttons gestartet wird (siehe: Abbildung 1: Fensteraufbau).

Die Auswahl der CAN-Hardware erfolgt per Seriennummer. Bei der Aktivierung des ,Passive mo-
de”, setzt der CanActor kein Acknowledgment-Flag auf dem CAN-Bus und es ist nicht maglich,
CAN-Nachrichten zu Ubertragen (Listen Only Mode).

Beschreibung zur Abbildung 5: Einstellungsdialog:

A - Auswahl der CanActor-Hardware

B - Passiver Modus, Unterdriickung der Quittierung von CAN-Botschaften
C - Einstellung des Hardwarefilters (siehe Mehrstufiges Filterungsverfahren)
D - Auswahl des CAN-Bus-Typs

E - Eingabe der benutzerdefinierten Baudraten

F — Aktualisierung der CanActor-Gerateliste

G - Auswahl des Transceiver-Typs

H — Auswahl der vordefinierten Baudraten



1.5 VERBINDUNG MIT DEM CAN-BUS

Das Verbinden mit bzw. Trennen vom CAN-Bus erfolgt lber zwei ToolButtons
in der Hauptwerkzeugleiste (siehe: Abbildung 6: Verbinden). Es ist notwendig, ﬁ, @
zuerst alle Konfigurationen vorzunehmen und Projektdateien zu la-

den/speichern, bevor man die Verbindung mit dem CAN-Bus herstellt. Bei einer
bestehenden Verbindung mit dem CAN stehen nicht alle Konfigurationsmog-

lichkeiten zur Verflgung. Dazu zdhlen alle Hardwareeinstellungen und das

Abbildung 6: Ver-
binden

Erstellen neuer Einzel-, Zyklus- und Response-Nachrichten, sowie das Andern der Zykluszeit von
zyklischen Nachrichten.

Beschreibung zur Abbildung 6: Verbinden:
A - Verbinden mit dem CAN-Bus

B — Trennen vom CAN-Bus



2 UBERTRAGUNG VON CAN-BOTSCHAFTEN

Die Ubertragung der CAN-Botschaften kann (iber die im Abschnitt |,

Abbildung 7: Handhabung der CAN-Nachrichten



Menlleiste” beschriebene Sendeleiste und das Nachrichten-Fenster erfolgen. Im Nachrichten-
Fenster lassen sich einzelne, zeitgesteuerte und ereignis-getriggerte CAN-Nachrichten vordefinie-
ren, bearbeiten und senden. Dazu benutzt man die Werkzeugleiste der jeweiligen Karteireiter des
Nachrichten-Fenster (Abbildung 7: Handhabung der CAN-Nachrichten). Die so definierten Bot-
schaften werden beim Speichern eines Projektes mit abgespeichert und lassen sich beim Laden
des Projektes wiederverwenden (siehe Abschnitt , Abspeichern und Laden von Projektdateien®).
Das Erzeugen neuer Nachrichten ist nur im Offline-Modus mdglich (keine bestehende Verbindung

Device messages | Single messages | Cwclic messages | Response messa ges

o =0 | Data | Cycletime | Active

= Retcic =) 00 00 00 00 00 00 00 00 100ms (]
= & Ad 22 55 2F 23 E4 100ms (]
G2 433Ex g DF FZ 34 E3E3 4534 23 100rms (]
&2 555x E] Remote Frame 1000415 (]
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= T
Erstellen einer Editieren einer
CAN-Nachricht CAN-Nachricht
IDE: ID: RTR: DLC: Cyclicc Cycle-Time:
= = e = 1000 |§) ms

em | Decimal | Binary

Idertifier: 1365 0 0000 0000 0000 0000 0101 0101 0101
Byts 1: 223 1101 1111
Byts 2: 242 1111 0010

Byte 3 52 0011 0100

Byte 4 227 11100011

Byte S 227 1110 0011
Byte &: &9 01000101
Byte 7: Se 0011 0100
Byke S 35 00100011

| v Add Message |

zum CAN-Bus).

Beim Anklicken des Werkzeugleisten-Buttons zum Erstellen oder Bearbeiten einer CAN-Botschaft
startet ein Bearbeitungsdialog, in dem die Nachrichtenparameter angepasst werden kdénnen. Im
folgenden werden einzelne Elemente des Dialogs erlautert (Siehe dazu).

Im Auswahlfeld ,IDE” stellt man das Extended-Format einstellen (29 Bit Identifier), ansonsten
wird das Standard-Format der CAN-Botschaft verwendet (11 Bit Identifier). Im Feld ,RTR" wahlt
man zwischen einem Remote-Frame (Datenanfrage) oder Data-Frame (Datenlbertragung) aus.
Beim Andern des DLC-Wertes (Data Length Code) passt sich automatisch der Eingabebereich fiir
die Botschaftsdaten an. Alle numerischen Eingaben erfolgen dabei hexadezimal. Unten im Bear-
beitungsdialog lasst sich durch einen Mausklick auf die Schaltflache ,Converter” eine Tabelle mit
einzugebenden dezimalen und bindren Werten des Identifiers und der Botschaftsdaten aufklap-
pen.

2.1 SENDEN VON EINZELNEN CAN-BOTSCHAFTEN

Im Karteireiter ,Single messages” des Nachrichten-Fensters findet man in der unteren Werkzeug-
leiste Buttons zum Erstellen, Editieren und Loschen von CAN-Botschaften (siehe Abbildung 8).




Nachdem man die Eingabe im Bearbeitungsdialog bestatigt hat, wird die CAN-Nachricht mit den
eingestellten Parametern in die Liste des Karteireiters ,Single messages” UGbernommen. Nun las-
sen sich die jeweiligen Nachrichten auf den CAN-Bus Ubertragen, indem man die entsprechende
LActive” Zelle des Listeneintrags anklickt, was durch einen Haken bestatigt wird. Nachdem die
Nachricht Ubertragen wurde, verschwindet der Haken wieder (im Normalfall unmerkbar schnell).
Bevor die Ubertragung stattfinden kann, muss eine Verbindung mit dem CAN-Bus aufgebaut
werden (siehe Abschnitt ,



Verbindung mit dem CAN-Bus”).

2.2 SENDEN VON PERIODISCHEN CAN-BOTSCHAFTEN

Periodische CAN-Botschaften werden nach der Aktivierung durchgehend mit dem eingestellten
Zeitintervall bzw. der eingestellten Zykluszeit versendet. Dies ist nttzlich, um CAN-
Echtzeitsysteme nachbilden zu konnen. Um zyklische Botschaften zu erstellen, zu editieren oder
zu l6schen benutzt man die untere Werkzeugleiste des Karteireiters , Cyclic messages” im Nach-
richten-Fenster (Abbildung 8). Beim Anklicken des Werkzeugleisten-Buttons zum Erstellen und
Bearbeiten der CAN-Botschaft startet ein Bearbeitungsdialog, in dem die Nachrichtenparameter
angepasst werden koénnen. Bei zyklischen Nachrichten ist im Bearbeitungsdialog ein zusatzliches
Eingabefeld zur Einstellung der Zykluszeit in Millisekunden vorhanden. Nachdem die zyklische
Nachricht beim Bestatigen der Eingabe im Dialog in die ,Cyclic messages” - Liste ibernommen
wurde, kann diese durch einen Mausklick in der ,Active”-Zelle des entsprechenden Listeneintra-
ges gestartet bzw. gestoppt werden. Das Aktivieren der Botschaften wird durch einen Haken in
der ,Active”- Zelle beststigt. Bevor die Ubertragung stattfinden kann, muss eine Verbindung mit
dem CAN-Bus aufgebaut werden (siehe Abschnitt ,,



Verbindung mit dem CAN-Bus”).

2.3 SENDEN VON EREIGNISGESTEUERTEN CAN-BOTSCHAFTEN

Die ereignisgesteuerten CAN-Botschaften werden nicht vom Benutzer selbst gesendet, sondern
nach einer Aufforderung des CAN-Buses bzw. eines CAN-Knotens. Einer Aufforderung entspricht
der Empfang eines Remote-Frames mit demselben Identifier wie die ereignis-getriggerte Nach-
richt selbst (Antwortnachricht oder ,Response message”). Das Erstellen/Bearbeiten und Léschen
der ereignisgetriggerten CAN-Nachrichten erfolgt Uber den Karteireiter ,Response messa-
ges” (Abbildung 8). Nachdem die Eingabe im Bearbeitungsdialog bestatigt wurde, wird die Bot-
schaft in die Liste Gbernommen und ist sofort aktiv. Um das Senden beim Empfang der entspre-
chenden Anfrage-Botschaft zu unterdriicken, muss die zugehorige ,active”-Zelle in der ,Response
messages” - Liste aktiviert bzw. deaktiviert werden. Aktivierte Nachrichten werden durch einen
Haken in dieser Zelle gekennzeichnet.
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2.4 SENDEN VON CAN-BOTSCHAFTEN AUS DER DATENBASIS

Nach dem Import einer CAN-Datenbasis (siehe Abschnitt Import/Export von CAN-Datenbasen),
besteht die Mdglichkeit, vordefinierte CAN-Nachrichten zu senden und die CAN-Signale flexibel zu
konfigurieren. Diese befinden sich in der Kartei ,Device messages”. Die Ansicht kann nach Sen-
deknoten, Nachrichten oder Signalen konfiguriert werden:

A - Auswahl der Knoten-basierten Ansicht

B — Auswahl der Nachrichten-basierten Ansicht
C - Auswahl der Signal-basierten Ansicht

D - Ausklappen aller Listenelemente

E — Einklappen aller Listenelemente

F — Starten des Bearbeitungsdialogs

Bei den zyklischen CAN-Nachrichten existiert in der Spalte ,Active” ein Auswahlfeld zum Aktivie-
ren/Deaktivieren des Versandes. Wahrend der CanMonitor nicht mit dem CAN-Bus verbunden ist,
ldsst sich somit auswahlen, welche CAN-Nachrichten/-Knoten aktiv geschaltet werden, nach dem
man die Restbussimulation gestartet hat. Wahrend einer bestehenden Verbindung zu dem CAN-
Bus lasst sich diese Konfiguration nur bei laufender Restbussimulation andern (s. 8. CAN-Bus-
Simualtion fur weitere Informationen). Neben der , Active”-Spalte gibt es noch die ,SingleShot"-
Spalte, mit der die Mdglichkeit besteht, beliebige CAN-Nachricht einmal zu versenden. Des weite-
ren lassen sich die Sendebotschaften so konfigurieren, dass nur die Empfangsbotschaften eines
oder mehreren CAN-Knoten(s) in der Ansicht erscheinen und bei der Restbussimulation aktiviert
werden. Dies lasst sich in dem Karteireiter ,,Bus simulation” des Einstellungsdialoges konfigurieren
(s. 8. CAN-Bus-Simualtion fur weitere Informationen).



3 TRACE-KONFIGURATION

Das Trace-Fenster dient der Darstellung des CAN-Bus-Verkehrs und enthalt diverse Funktionen fir
den Aufbau einer, auf den jeweiligen Anwendungsbereich zu-geschnittene CAN-Analyse-
Umgebung. So lassen z.B. beliebig viele Trace-Fenster erstellen und durch umfangreiche Anzeige-
und Filterungsfunktionen individuell gestalten.

CAN-Traffic | Tx-Msgs | Crelate
Tireskarp | Message | Dir | I D | Message Data | Transrmitter |Fra &
P G2 00:00:01.144 BEM_02 R 663 = 00 00 a0 0o oo 0o 00 0o Gateway_MOE Datk
P 5 00:00:01.157  Gateway 73 Rx  3DC 5 0000102700000000 Gateway MOE Dat
P G 00:00:01, 236 Gateway _73 Rx SDic =3 00 00 10 27 00 00 a0 0o Gateway _MOE Cak
P G 00:00:01,240 Klemmen_Status... Rx SC0 4 00 0o 0z 0o BCM_MOE Cak
P 2 00:00:01.242 izateway_71 Rx a0a g 00 0000 10 27 0000 00 GGateway _MOE Crak
P 2 00:00:01.244 BEM_02 Rx 53 g 00 00 00 00 00 00 00 00 GGateway _MOE Crak
P 5 00:00:01.288  Gateway 73 Rx  3DC 5 0000102700000000 Gateway MOE Dat
P 5 00:00:01.338  Gateway 73 Rx  3DC 5 0000102700000000 Gateway MOE Dat
P G2 00:00:01, 540 Klemmen_Status... Rx SC0 4 00 0o 0z 0o BCM_MOE Cak
P G 00:00:01,342 Gateway_71 Rx SDa =3 00 00 00 10 27 00 a0 0o Gateway _MOE Cak
P 2 00:00:01, 344 BEM_02 Rx 53 g 00 00 00 00 00 00 00 00 GGateway _MOE Crak
P 3 00:00:01,337 izateway_73 Rx S0z g 0000 10 27 00 00 00 00 GGateway _MOE Crak
P 5 00:00:01.437  Gateway 73 Rx  3DC 5 0000102700000000 Gateway MOE Daf
P 5 00:00:01.439  Klemmen Status.. Rx  3C0 4 00000200 BCM_MQB Daf —
P G2 00:00:01.441 Gateway_71 Rx SDa =3 00 00 00 10 27 00 a0 0o Gateway _MOE Cak 1
P 59 00:00:01.443  BEM_OZ Rx 663 & 000000O0O0D0O000 —Gatewsy MOE  Daty
P 3 00:00:01. 435 izateway_73 Rx S0z g 0000 10 27 00 00 00 00 GGateway _MOE Crak
[ 1l ] >
P O X & B T @& & F OO

060 06060 O OOO

Abbildung 8: Trace-Fenster

3.1 TRACE-FENSTER-KONFIGURATION

A - Erstellen einer neuen Trace-Ansicht

B — Traffic-Scan starten

C - Traffic-Scan beenden

D - Starten des Dialoges zur Filter- und Pufferkonfiguration

E — Umschalten zwischen absolutem und relativem Zeitstempel
F — Umschalten zwischen flieBender und statischer Traffic-Darstellung
G - Leeren der Traffic-Liste

H — Vergabe eines Namens flr die Trafficansicht

| - Trafficansicht im Karteireiter andocken

J — Trafficansicht vom Karteireiter abdocken

K — Beenden der Trafficansicht

In der Trafficansicht werden einzelne CAN-Nachrichtenelemente in Spalten aufgeteilt. Jede Nach-
richt entspricht einem Listeneintrag oder Zeile. Beim Aufklappen einer CAN-Nachricht werden die



untergerordneten Signale dargestellt. , Timestamp” enthalt die Zeitstempel-Information, getrennt
nach HH:MM:SS.ms. Bei dem Zeitstempel handelt es sich im absolutem Modus (siehe Abbildung
9, E - Umschalten zwischen absolutem und relativem Zeitstempel) um den absoluten Zeitwert
nach der Verbindung mit dem CAN-Bus. Der relative Zeitstempel entspricht bei der flieBenden
Trafficanzeige den Zeitintervall bezliglich der vorherigen Nachricht und bei der statischen Traffi-
canzeige den Zeitintervall bezlglich des letzten Sendens/Empfanges einer Nachricht mit dem
gleichen CAN-Identifier. Somit lasst sich im letztem Fall die Zykluszeit einer zyklischen Nachricht
leicht analysieren. Die Spalte ,Message” enthélt den in der CAN-Datenbasis definierten Bot-
schaftsnamen der Nachricht. Die Spalte ,Dir” entspricht der Direction bzw. der Nachrichtenfluss-
richtung, wobei ,RX" fUr ,received” (empfangen) und , TX" flr ,transmitted” steht. Der nachste
Eintrag ,ID" enthdlt den Identifier-Wert in hexadezimaler Form, wobei die Extended-ID mit einem
X" am Ende gekennzeichnet wird. ,,DLC" beinhaltet den Data Length Code bzw. die Anzahl der
gesendeten/empfangenen Botschaftsdaten, wonach im néachsten Eintrag ,Message Data” die
Daten selbst in hexadezimaler Form dargestellt werden. In der Spalte , Transmitter” wird der in
der CAN-Datenbasis definierte Knotenname des Sendeknotens dargestellt. Die Spalte ,Frame
info” enthalt Informationen zu dem Nachrichtentyp (Remote = Datenanfrage, Data = Daten-
transport, Single = Einzelnachricht, Cyclic = zyklische Nachricht, wobei die letzten zwei Parameter
nur bei den Sendenden Nachrichten angezeigt werden). Die letzte Spalte ,Count” beinhaltet im
flieBenden Modus die absolute Nachrichtennummerierung und im statischen Modus die Anzahl
der empfangenen Nachrichten mit dem selben Identifier. Zur Schonung der Ressourcen ist fir
jede Trafficansicht ein Puffer mit definierbaren Anzahl der Nachrichteneintrage bereitgestellt. Der
Puffer lasst sich im Dialog zur Filter- und Pufferkonfiguration einstellen (siehe Abbildung 9, D).
Moglicher Wertebereich - 1.000 bis 20.000 Nachrichten, wobei als Standardwert bzw. Startwert
beim Erstellen einer Trafficansicht, 2.000 festgelegt wird.
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Abbildung 9: Trace-Filterkonfiguration

3.2 TRACE-FILTERKONFIGURATION

Es ist moglich fir jede erstellte Trace-Ansicht einen individuellen Filter zu konfigurieren. Dazu star-
tet man den entsprechenden Einstellungsdialog durch das Anklicken der Schaltflache ,,D” aus der
Abbildung 8: Trace-Fenster. Im gestarteten Dialog lassen sich beliebig viele CAN-Botschafts-
Identifier Bereiche festlegen, die als Sperr- oder Durchlassbereiche dienen (siehe: Abbildung 9:
Trace-Filterkonfiguration).

Die erzeugten Durchgangsbereiche werden in einer Liste dargestellt, wobei sich die Konfigurati-
on ,Include / Exclude” auf alle davon auswirkt. Mit der Auswahl des Include-Modis werden alle
Eintrdge in der Liste zur Durchlassbereichen, im Exclude-Modus dagegen zur Sperrbereichen. Je-
der einzelner ID-Bereich besitzt zusatzliche Eigenschaften, die weitere Durchgangsbedingungen
bestimmen und in den sechs letzten Spalten jedes Listeneintrags in Form von Auswabhlfeldern zu
Verflgung stehen. Bei der Erzeugung eines Eintrags sind alle Filtereigenschaften ausgewahlt (Ha-
ken gesetzt). Durch Entfernen eines Hakchens, schlieBt man alle CAN-Botschaften mit der jeweili-
gen Eigenschaft aus dem entsprechenden ID-Bereich aus.

Nachfolgend werden alle verfligbaren Eigenschaften erklart:

Eigenschaft Steht fir Beschreibung

Rx Receive Alle vom CanMonitor empfangene Nachrichten
Tx Transmit Alle vom CanMonitor sendende Nachrichten

IDS Standard-ID Alle Nachrichten mit Standard-ID-Format (11 Bit)
IDE Extended-ID Alle Nachrichten mit Extended-ID-Format (29 Bit)
RTF Remote-Frame Alle Daten-Anfrage-Nachrichten

DF Data-Frame Alle Nachrichten, die Daten Ubertragen




Beispiel

Bei der folgenden Konfiguration:

Stark-ID End-ID T= | Rx | IS | IDE | RTF | OF
00000002 OOOOZ3EE [ O ]

in Verbindung mit dem Include-Modus, werden alle Nachrichten, die einen Identifier >= 2 und <=
23EE (hex) haben, nicht von dem CanMonitor gesendet wurden, Extended-ldentifier-Format be-
sitzen und keine Daten-Anfrage-Nachrichten sind, im Trace-Fenster angezeigt.

In Verbindung mit dem Exclude-Modus, werden dagegen alle Nachrichten, die einen Identifier <2
und >23EE (hex) haben, von dem CanMonitor gesendet wurden, Standard-ldentifier-Format be-
sitzen und Daten-Anfrage-Nachrichten sind, im Trace-Fenster angezeigt.

Durch Kombination von x-beliebigen Durchgangsbedingungen erreicht man nahezu jede magli-
che Filterkonfiguration.

4 BUS-TRAFFIC AUFZEICHNEN

In unterschiedlichsten Anwendungs- und Testfallen bendtigt man oft die Information des CAN-
Busverkehrs Uber langere Laufzeiten. Um Dauertests eines CAN-Knotens bzw. CAN-Buses durch-
zuflhren, enthalt der CanMonitor die Funktion der Traffic-Aufzeichnung. Mit der Funktion wird
es ermdglicht, die gesamte Businformation Uber eine beliebige Zeitdauer in Textform abzuspei-
chern.

Das Starten und Beenden der Trafficaufzeichnung erfolgt Gber zwei Buttons in der Hauptwerk-

zeugleiste (siehe Abbildung 11).
Beschreibung zur Abbildung 11:
A - Starten der Traffic-Aufzeichnung

B - Beenden der Traffic-Aufzeichnung



traffic.txt - WordPad M==
Datei Bearbeiten  Ansicht  Einfigen  Format 2
DEHE SR # @ B
go0:00:17.429 3D Bx d § 00 00 10 27 00 0O 0o oo
oo:00:17.431  3CO Rx d 4 00 00 02 00
00:00:17.434 3Di Rx d § 00 00 o0 10 27 00 0O oo
00:00:17.436 663 Bx d § 00 00 00 00 Q0 o0 oo oo
00:00:17.4353 3EE Bx d § 00 00 00 00 00 OO 0o oo
oo:00:17.440 3D1 Bx d § 00 00 00 00 Q0 0O oo oo
go:00:17.442  5F0 Bx d 5§ 64 32 00 00 OO0 0O OO oo bl
Driicken Sie F1, um die Hilfe aufzurufen. MF

Abbildung 12: Aufzeichnen des
CAN-Bus-Verkehrs in Textform

Bevor die Aufzeichnung beginnt, muss eine Textdatei ausgewahlt werden, in welche die Traffic-
Information gespeichert werden soll. Hierfir wird beim Anklicken des Start-Buttons ein Datei-
auswahldialog eingeblendet, in dem man eine neue Datei auswahlen oder erstellen kann. Die
Speicherung des CAN-Verkehrs erfolgt im 60 Sekundentakt bzw. nach dem Beenden der Auf-
zeichnung, wobei die Information jedes mal am Ende der Textdatei hinzugefligt wird. Die Textda-
teien mit den Aufzeichnungen lassen sich mit beliebigen Text-Editoren betrachten oder untersu-
chen (siehe Abbildung 12).

5 MEHRSTUFIGES FILTERUNGSVERFAHREN

Dem Benutzer des CanMonitors steht ein mehrstufiges Filtersystem zu verfligung. Dabei handelt
es sich um einen Hardwarefilter und die Traffic-Filter jeder Traffic-Anzeige (siehe 3.2 Trace-
Filterkonfiguration). Wie in der Abbildung ... ersichtlich wird, handelt es sich bei dem Hardwarefil-
ter um einen globalen Filter, der Auswirkungen auf alle Traffic-Anzeigen, sowie die Trace-
Aufzeichnung (siehe 4 Bus- Traffic aufzeichnen) mit sich bringt. Dieser Filter kann bei einer sehr
hohen Busauslastung die Applikationsebene entlasten, indem man diesen so konfiguriert, dass
nur die flir den Anwendungsbereich relevante CAN-Botschaften von der CanActor-Hardware zum
PC Ubertragen werden.




Abbildung 13: Mehrstufiges Filtersystem
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Abbildung 14: Konfiguration des
Hardwarefilters
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Der Hardwarefilter setzt sich aus einem Identifierwert und der Filterungsmaske zusammen, die
man im Ein-stellungsdialog konfigurieren kann (siehe 1.4 CAN-Bus-Einstellungen). Wenn man die
beiden Werte sich binar vorstellt, so entspricht die Maske der Bitstellen an auf die man filtern will
(alle Bitstellen mit der Wertigkeit eins) und der Identifierwert die eigentliche Bitstellen-werte. Ein
Beispiel dazu: ID= 1111 (bin), Mask = 1010 (bin), dann erhalten wir als Ergebnis 1x1x(bin), wobei

x" einer Bitstelle entspricht, auf die nicht geachtet bzw. nicht gefiltert wird.Um die Hardwarefil-



terkonfiguration zu erleichtern, werden die oben genannten drei Werte in bindre Werte automa-
tisch umgewandelt und als Tooltip angezeigt. Dazu muss der Mauszeiger an die Position der bei-
den Eingabefeldern gesetzt werden (siehe Abbildung 14). Mit den Auswahlfeldern "IDE" und
"IDS" wahlt man zwischen dem Standard- (11 Bit) und Extended-Identifierbereich (29 Bit) aus. Das
Aktivieren und Deaktivieren erfolgt Uber einen Einpressbutton , Activate filter”.

6 ABSPEICHERN UND LADEN VON PROJEKTDATEIEN

Um die Programmkonfiguration nicht mehrmals durchflihren zu missen, besteht die Mdglichkeit,
CanMonitor-Konfigurationen im XML-Format abzuspeichern und zu laden. Dies kann Uber die
Buttons der Hauptwerkzeugleiste und Uber den Menlpunkt ,File” der Menlleiste vorgenommen
werden (siehe Abbildung 15).

A - Neues Projekt erstellen.

B - Projekt 6ffnen. Cj

C - Projekt speichern.

D - Projekt unter anderem Namen speichern.

E - Projekt schlieBBen. Abbildung 15
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7 IMPORT/EXPORT VON CAN-DATENBASEN

Der CanMonitor unterstlitzt zwei CAN-Datenbasistypen: .dbc- (nur Import) und .xml-Format (Im-
port und Export). Der Import kann mittels Menlileiste->File->Import CAN database oder folgen-
den Toolbutton der Werkzeugleiste erfolgen:

Der Export im xml-Format erfolgt mittels Menuleiste->File->Export CAN database. Beim Abspei-
chern und Laden von Projektdateien wird die Datenbasis automatisch mitabgespeichert/-geladen.
Wird eine Projektdatei als Datenbasis importiert, so werden nur die in der Datenbasis definierten
Eigenschaften, jedoch keine weitere Einstellungen Gbernommen.

8 CAN-BUS-SIMULATION

Nach dem Import einer CAN-Datenbasis lassen sich alle in diesen definierte CAN-Nachrichten Uber
den Karteireiter ,Device messages” der Nachrichten-Ansicht konfigurieren. Nach dem man eine
Verbindung mit dem CAN-Bus aufgebaut hat, besteht die Méglichkeit eine einfache Bus-
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Simulation, bestehend aus den in der Datenbasis definierten zyklischen Nachrichten, lber die

.
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folgende Toolbuttons der Werkzeugleiste zu starten und zu beenden:

Alternativ geschieht dies Uber die Menlleiste->Run->Run bus simulation bzw. Mendleiste->Run-
>Stop bus simulation. Wahrend der laufenden Bussimulation lassen sich CAN-Signalwerte dndern
und CAN-Nachrichten, sowie gesamte CAN-Knoten aktivieren und deaktivieren. Im Normalfall
werden beim Start der Simulation alle in der Datenbasis existierende zyklische Nachrichten akti-
viert. Hat der Benutzer jedoch einen oder mehrere CAN-Knoten bzw. Steuergerdte an den CAN-
Bus angeschlossen, so ist es notwendig, durch das Deaktivieren des Auswahlfeldes der Nachrich-
tenansicht (Spalte ,Active”), den/die jeweilige(n) Steuergerat(e) zu deaktivieren. Andernfalls
werden die CAN-Nachrichten des jeweiligen Knotens beidseitig versendet. AuBerdem besteht die
Moglichkeit nur die Empfangsbotschaften des angeschlossen CAN-Knotens/Steuergerates zu
senden. Somit wird die Trace-Ansicht Ubersichtlicher. Ein weiterer Vorteil besteht darin, dass die
Nachrichtenansicht sich auf die Einstellung automatisch anpasst und somit das Auffinden bzw.
Konfiguration, der flr den angeschlossenen Knoten relevanten CAN-Nachrichten bzw. Signalen,
durch die kleineren Listen einfacher wird. Die Konfiguration ldsst sich in dem Karteireiter ,Bus
simulation” des Einstellungsdialoges vornehmen:



Der realer, an den CAN-Bus angeschlossener Knoten, sollte in der Spalte ,Simulated” nicht ver-
merkt sein. Hinweis: nach dem Import einer CAN-Datenbasis sind alle Knoten als ,Simula-
ted” eingestellt.
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